
A-10 Cuba Information: The Windows 95 Version

Minimum System Requirements for the Windows 95 version



Activision Customer Support

If you have any comments, questions or suggestions about A-10 Cuba or any other Activision
product, please feel free to contact us. If you are experiencing difficulty please consult the A-
10 Cuba Help file before contacting Customer Support. The help file contains the answers to 
some of our most frequently asked questions and may quickly provide a solution to your 
problem. If, after reviewing the A-10 Cuba Help file, you are still experiencing problems, 
please feel free to contact us through any of the services listed. So that we can better help 
you, please be at your computer and have the following information ready:

1. Complete product title

2. Exact error message reported (if any) and a brief description of the problem

3. Your computer's processor type and speed (e.g. 486DX2/66, Pentium 90MHz...)

4. Video and sound card makes and models (e.g. Diamond Stealth 64 video, Sound Blaster 
16 sound...)

Customer Support:

North America

UK and Europe

Australia and Pacific Rim

For Technical Support and Customer Service in areas not listed, please contact your local distributor or 
Activision via online. (Please note, online support is in English only.)

Locations for Updates and/or Patches:

Where do I go for Game Updates and/or Patches?



AutoPlay

If the A-10 Cuba title screen does not appear, try performing the following steps:

1. With the disc in your CD-ROM drive, double-click on the My Computer icon on your 
desktop or right-click on it and select the Open option.

2. In the View pull-down menu, select Refresh.

3. Double-click on the A-10 Cuba CD icon in the window or right-click on it and choose the 
AutoPlay option.

4. After the A-10 Cuba title screen appears, click on the Play button (it will appear as 
Install before you have installed the game).

If the title screen still does not appear, please check the following:

1. Make sure the CD is clean and properly placed in the CD-ROM drive.

2. Verify that your CD-ROM driver is optimized for use with Windows 95. To do this:

a. Open the Control Panel and double-click on the System icon. Click on the 
Performance tab. If any of your hardware drivers are not fully optimized for use with 
Windows 95, they will be listed here with an explanation of the exact problem and 
suggestions on how to fix it. If you cannot get your system to perform optimally, 
please consult Microsoft support.

b. Or, Click here to begin the Hardware Conflicts Troubleshooter .

3. Verify that the Auto-Insert Notification for your CD-ROM is enabled. To do this:

a. Choose the System Properties dialog box by right-clicking on the My Computer icon 
and then clicking on Properties.

b. Choose the Device Manager tab in the dialog box.

c. Select and double click CD-ROM.

d. Select your CD-ROM drive and click the Properties button.

e. Select the Settings tab of the Properties dialog box.

f. Make sure the Auto-insert notification box is checked. If not, click on it to make it 
checked.

g. Click OK to accept your changes.

4 Double-click on the My Computer icon on your desktop. Select the Refresh option 
located in the View pull-down menu of your system window. When the A-10 Cuba icon 
appears, double click on it; The A-10 Cuba title screen should appear.



5. If the game is already installed you can also start A-10 Cuba from the Start button on 
your desktop. Click the Start button from your taskbar, select Programs|A-10 Cuba|A-
10 Cuba and this will allow you to start the game.

If for some reason you do not wish to use AutoPlay, you can turn it off using the 
following steps:

1. Choose the System Properties dialog box by right-clicking on the My Computer icon 
and then clicking on Properties.

2. Choose the Device Manager tab in the dialog box.

3. Select and double click CD-ROM.

4. Select your CD-ROM drive and click the Properties button.

5. Select the Settings tab of the Properties dialog box.

6. Click the Auto-insert notification box so that it is unchecked.

7. Click OK to accept your changes.



Before The Installation

- This game uses Microsoft DirectX 2 video and audio drivers. It is important that you 
check with your audio and video card manufacturer to determine if your hardware will 
support DirectX. Please see the DirectX 2 section in this file for more information.

- This game should not be installed to a compressed drive.

-           Please make sure your computer system is 100% Windows 95-compatible; A-10 
Cuba for Windows 95 is not compatible with Windows 3.1.

-           To operate best, A-10 Cuba requires that your system have the latest Windows 95 
32-bit drivers for your CD-ROM drive, sound card and video card. If you have any 
problems running the program, outdated drivers are the most likely cause.

-           If you need help obtaining the latest sound and video drivers, check out the Vendor 
List. 



Can I install A-10 Cuba to a hard drive that is 
compressed?
 
We do not recommend installing this program to a compressed drive. Please install to a non-
compressed drive and run the program from there.



Can I run A-10 Cuba under Windows 3.1, Windows 
NT or OS/2?

Unfortunately, the answer to this question is no. Please see Supported Operating Systems 
for more information.



Changing Standard Windows 95 Cursors

Check to make sure that you have not changed the standard Windows 95 cursors. Doing so may cause 
video corruption. We have especially found this to be the case with 3D and animated cursors.



Checking Your Sound Card for Conflicting Settings 
(Windows 95)

To check your sound card for conflicting settings:

1. Go to the Start menu on your task bar, select Settings|Control Panel.

2. Double-click on the System icon, then choose the Device Manager tab.

3. Select and double click Sound, Video, and Game Controllers, then double-click on 
your specific sound card.

4. Check the Device Status box to see if your card is working properly.

5. Select the Resource tab and check the Conflicting device list for any conflicting devices.

If you purchased your sound card before the release of Windows 95, you may obtain 
updated drivers from a variety of places. Most hardware retailers have access to the most 
recent drivers. Additionally, most sound card manufacturers maintain a BBS containing the 
latest drivers for free downloading. Drivers are also available on CompuServe, America 
Online, the Microsoft Network and other popular online services. A list of sound card 
manufacturers and their Technical Support and BBS numbers is available in this document. 
Please make every effort to install the latest Windows 95 sound drivers before calling 
Activision Customer Support.



Color Settings

A-10 Cuba utilizes the Direct Draw libraries of Microsoft's DirectX. Some video cards do not 
yet have driver support for Direct Draw. Updated drivers are being developed by 
manufacturers to remedy this. To obtain information on these updates, contact your video 
card manufacturer and download their latest Windows 95 drivers for your video card. If you 
are not sure about your video card or its capabilities, please refer to the section called Check
Your Display Type Settings for more information, or contact    your video card manufacturer.

To Change Your Color Setting:

You need to change the Color palette box of the window shown below to at least 256 Color.
To go to the Display Properties window to change it, click here.

If you choose to make this change at some other time, you can always return to this Help file
and try again, or follow the steps listed below to access these settings.

1. Place your mouse cursor over an empty area of your desktop and click the right button 
on your mouse. At the bottom of the list that appears, click on Properties. This will bring
up the Display Properties window. You can also bring this window up by clicking on the 
Display icon in the Control Panel.



2. Choose the Settings tab and change the color setting to 256 Color as shown in the 
Color palette box above.

If you have a video card that supports 256 Color, but you cannot select this as an option, 
check to see that you have the most updated Windows 95 video driver.



Common Audio Problems when Playing in Windows 
95

Installing a new sound card.

I just installed a new sound card. How come I’m not getting any sound?

Checking your sound card for conflicting settings.

I have only partial or no sound when running the game  .  

The volume levels of my music, sounds effects or game voices are too low for me 
to hear. What can I do?

I have a Diamond Telecommander sound/modem card and it does not work with the game.    What 
do I do?

I have a Packard Bell with little and/or no sound when playing the Windows 95 version of   A-10   
Cuba  .    I need help!  

I have an Advanced Gravis UltraSound ACE and I am experiencing severe lock-up 
problems.



Common Input Device Problems when Playing in 
Windows 95

General Troubleshooting for Joysticks and Game Pads

Joystick Calibration

Mouse



Common Installation Problems when Playing in 
Windows 95

I uninstalled   A-10 Cuba   and there is no option to re-install the game, (i.e. I can only choose play as  
an option) what should I do?

Can I install   A-10 Cuba   to a hard drive that is compressed?  



Common Tips & Troubleshooting for General Issues 
(Windows 95)

My screen saver runs really slow when   A-10 Cuba   is running. What can I do about   
that?

The fonts on my game screen are too large and extend off the screen. Why is this 
happening?

Game Freezes or Crashes

Power Saver Functions

Can I run   A-10 Cuba   under Windows 3.1, Windows NT or OS/2?  

Ctrl-Alt-Del locks up my system.

How can I improve Performance?

Where do I go for Game Updates and/or Patches?



Common Troubleshooting Tips for the Windows 95 
Version of A-10 Cuba
 
Activision thoroughly tests its games on a variety of systems before they are released, but it 
is virtually impossible to test on all combinations of software and hardware. Many of the 
issues you may encounter in Windows 95 are caused by device drivers for video cards, 
sound cards and CD-ROM drives that are not fully compatible with the Windows 95 operating
system. The following troubleshooting tips are intended to assist you in solving some of the 
common issues that occur with the Windows 95 operating system and A-10 Cuba.

Installation - This will focus on basic problems that might occur during the installation 
process.

DirectX 2 - This will explain the DirectX 2 process and state general answers to frequently 
asked questions.

Autoplay - This is where to go if you are encountering problems with the title screen 
automatically appearing.

Video - Where to go if you are encountering video related problems.

Audio - Where to go if you are encountering audio related problems.

Input Devices - Where to go if you are encountering input device related problems (e.g. 
mouse, joystick, or gamepads).

General Issues - Commonly asked questions.



Common Video Card Problems when Playing in 
Windows 95

How do I set my display to 256 Color?

Video Driver Settings

While I’m playing   A-10 Cuba   the image is very choppy and slow.   

I installed a new video card, and the game doesn't look right. What do I do?

Changing the standard Windows 95 cursors causes video corruption.

I've installed the game, and DirectX 2 setup completed correctly. When I launch   A-10 Cuba   from   
the title screen or from the taskbar, my screen stays blank and the game doesn't start. What 
should I do?

Game Graphics Are Faded or Strange in Appearance.

I am using large fonts on my system, and the text in the game is messed up, what can I do?
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Ctrl-Alt-Del Locks Up My System

Do not use the Ctrl-Alt-Del function to quit A-10 Cuba. Instead select Quit from the Option menu to exit 
the game.



Customer Support: Australia and Pacific Rim

ACTIVISION AUSTRALIA and PACIFIC RIM
P.O. Box 873
Epping, NSW 2121
Australia

Phone: 1902 962 000

Online Services

Services with Activision Forums, E-mail and File Library Support (available 
in English only):

Microsoft Network: From any MSN window, pull down the Edit menu and select Go 
To and then Other Location. At the prompt, type "Activision" 
and click OK.

CompuServe: 76004,2122 or [GO GAMBPUB]
Activision BBS: 310-479-1335 Up to 28,800 baud; Settings: 8 Bits, No Parity, 1 

Stop Bit (8, N, 1)
Internet: support@activision.com
World Wide Web: http://www.activision.com



Customer Support: North America

Online Services:

Services with Activision Forums, E-Mail and File Library Support:

Microsoft Network: From any MSN window, pull down the Edit menu and select Go 
To and then Other Location. At the prompt, type "Activision" 
and click OK.

America Online: Use keyword "Activision" to locate the Activision forum
CompuServe: 76004,2122 or [GO GAMBPUB]
Activision BBS: 310-479-1335 Up to 28,800 baud; Settings: 8 Bits, No Parity, 1 

Stop Bit (8, N, 1)
Internet E-mail: support@activision.com
World Wide Web: http://www.activision.com

Fax:

310-479-7355, 24 hours a day

FaxBack:

310-473-6453, 24 hours a day

Mail:

Activision
Customer Support
P.O. Box 67713
Los Angeles, CA 90067

Phone:

Call our 24-hour voice-mail system for answers to our most frequently asked 
questions at 310-479-5644. Contact a customer support representative at the same 
number between the hours of 9:00am and 5:00pm (Pacific Time) Monday through 
Friday, except holidays.



Customer Support: UK and Europe

Activision
Long Island House, 3A
1/4 Warple Way
London, W3 ORQ
United Kingdom.

Technical Support: 0990 143525
Customer Service: 0181 7429400

You can contact UK Customer Service between the hours of 1:00pm and 5:00pm (UK Time) 
Monday through Friday.

Online Services:

Services with Activision Forums, E-Mail and File Library Support (available 
in English only):

Microsoft Network: From any MSN window, pull down the Edit menu and select Go 
To and then Other Location. At the prompt, type "Activision" 
and click OK.

CompuServe: 76004,2122 or [GO GAMBPUB]
Activision BBS: 310 479-1335 Up to 28,800 baud; Settings: 8 Bits, No Parity, 1 

Stop Bit (8, N, 1)
Internet E-mail: support@activision.com
World Wide Web: http://www.activision.com



Diamond Telecommander Sound/Modem Card

You will want to contact Diamond Multimedia and get a new driver for your Telecommander 
2500XL/3500XL sound/modem card.    The Telecommander update at the Digital and/or Diamond web site
is NOT a Windows 95 driver.    The only way to get the correct updated driver is to call Diamond and they 
will mail it to you.    The version of the driver you need is 1.12 or higher.

After the new driver has been installed, reinstall the game.    This should allow the game to run without 
crashes or sound problems.



DirectX 2

Upon completion of the A-10 Cuba setup, the install process will continue by determining if 
Microsoft DirectX 2 needs to be installed on your computer. If so, the Microsoft DirectX 2 
setup program will install the appropriate files on your computer. If you choose not to install 
DirectX 2, and you find that later you need to install DirectX 2, follow these directions. With 
the disc in your CD-ROM drive, install Microsoft DirectX 2 by right-clicking on the A-10 Cuba
CD icon to get the Context menu. From that menu, select Install DirectX.

Important Note:    If you have a newer version of DirectX (e.g. DirectX 3) installed on your 
computer, please install DirectX 2.    Some files that are needed to run the game only come 
with DirectX 2.    Installing DirectX 2 will not replace newer drivers installed by DirectX 3, but 
will only add drivers not previously installed.

What is DirectX 2 and why do I need it?

Microsoft's DirectX 2 is an API (Application Programming Interface) set that increases the speed at which 
games play under the 
Windows 95 operating system. These APIs allow direct access to the enhanced features of hardware 
under Windows 95. With DirectX 2, a program has instant access to the hardware, allowing for great 
advances in graphics, sound, video, 3-D, and network capabilities of games.

Since Windows 95 and DirectX 2 are relatively new in the computer world and have not achieved 
compatibility with some older video cards, many manufacturers are releasing updated drivers for 
Windows 95 to meet the DirectX 2 standard. If you are not sure about your video card's compatibility, 
consult the company that makes your video card.

If the Microsoft DirectX 2 Installer does not detect DirectX 2 on your computer, it will install DirectX 2 for 
you. After installation is complete, you will need to restart your computer in order for DirectX 2 to take 
effect.

If you have other Windows 95 games on your computer, chances are you already have an earlier version 
of DirectX installed on your computer. In this case, the Microsoft Installer will write over that version with 
DirectX 2.    At that point, the DirectX 2 installation process will be complete. You will need to restart your 
computer for the changes to take effect.

If however, you already have DirectX 2 installed on your computer, the Microsoft DirectX 2 installer will 
detect that and not overwrite any DirectX 2 files.    You will not need to restart your computer after 
installation in order to run A-10 Cuba.

DirectX 2 should not affect any titles designed for the original version of DirectX. Should you encounter 
difficulties with DirectX 2, please contact Microsoft for further information.    

How do I check to see if my computer supports Direct X?

1. Place the game CD in the CD-ROM drive and exit from any autoplay screens.
2. Click on the START button and choose RUN.
3. Assuming D: as your CD-ROM drive, Type D:\DIRECTX\DXSETUP and press <Enter>.

or

1. Double-Click on My Computer.
2. Right-Click on your CD icon.



3. Select Install DirectX.

If any of the components of DirectX 2 are not certified please call your hardware manufacturer for the 
updated drivers that support DirectX.

I have heard DirectX 2 is not compatible with some video cards. What can you tell me about that?

Windows 95 and DirectX 2 are relatively new in the computer world and have not achieved compatibility 
with some older video cards. Many manufacturers are releasing updated drivers to meet the DirectX 2 
standard. If you are not sure about your video card's compatibility, consult the Vendor List for the 
company that makes your video card.

If I don't have DirectX 2 will A-10 Cuba for Windows 95 install it for me?

Yes. If the Microsoft DirectX 2 Installer does not detect DirectX 2 on your computer, it will install DirectX 2 
for you. After installation is complete, you will need to restart your computer in order for DirectX 2 to take 
effect.

If the Installer copied over DirectX, will the UnInstaller remove DirectX 2? How 
will this affect my other Windows 95 games?

DirectX 2 will remain on your computer and you will be able to run other Windows 95 games 
that use Microsoft’s DirectX 2 libraries.    DirectX 2 should not affect any titles designed for 
the original version of DirectX.    Should you encounter difficulties with DirectX 2, please 
contact Microsoft for further information.    

In some cases where video cards may not be compatible with DirectX, we have provided 
steps to manually remove DirectX 2 and restore your system to its former condition. 
Microsoft does not provide an uninstall feature for DirectX, so this manual method is the only
way to remove it from your system.

How to recover from a bad DirectX 2 installation:

If, after installing DirectX 2 on your system, you find that your system is not compatible with 
DirectX, don't panic. We have included a brief walk-through to get you back to your old 
setup.

1. If your system will run, allow Windows 95 to load. If your system will not run, load 
Windows 95 in Safe Mode by restarting your system and pressing F8 when you see the 
Starting Windows 95 message appear on-screen during boot up. Select Safe Mode.

2. Right click on the My Computer icon and select Explore. If you loaded Windows 95 in 
Safe Mode and can see the icon for your CD-ROM drive, continue. If you do not see the 
CD-ROM icon, then please stop here and perform the steps listed in the "No CD Icon in 
Safe Mode section."

3. Insert the A-10 Cuba disc into your CD-ROM drive and hold down the Shift key while 
closing the drive. This will prevent the autoplay title screen from loading.

4. Go to the DirectX 2 directory on the CD (or the one you copied to the hard drive if you 
had to follow the No CD Icon in Safe Mode procedure). Double-click on the application 



DXSETUP. The following box will appear:

5. Click on Restore Windows 95 drivers. You will be asked to insert your Windows 95 CD 
or diskettes in order to restore your drivers. You will receive a message asking you to 
restart your system. After Windows 95 reloads, everything should be returned to it's 
original state before the DirectX drivers were installed.

No CD Icon in Safe Mode

1. Take your A-10 Cuba disc to another Windows 95 system that is operable and where you 
can copy some files.

2. Insert the A-10 Cuba disc into the CD-ROM drive and hold down the Shift key while 
closing the drive. This will prevent the autoplay title screen from loading.

3. Right-click on the My Computer icon and select Explore. Go to the CD-ROM drive that 
contains the A-10 Cuba CD.

4. Drag the DirectX 2 folder to a blank 1.44 MB floppy disk. You will need three blank 1.44-
MB diskettes to copy all of the necessary files. Take the floppy disks back to your 
computer and copy the directories contained on them to your hard drive.

5. Go to Step 4 in the "How to Recover from a Bad DirectX 2 installation" section above and 
complete the process.



Electronically Registering in Windows 95
There are three ways to access the registration for Windows 95:

1. Select Register Now during the installation process.
2. Insert the CD. From the A-10 Cuba title screen, click on More. Then, click on Electronic 

Registration.
3. Right-click on the A-10 Cuba CD icon with the disc in your CD-ROM drive and select 

Electronic Registration from the menu.



Game Freezes or Crashes in Windows 95

1. Make sure your system has at least 8MB of RAM and a 486DX2/66 processor.    Trying to 
run the game on a lesser machine may result in hardware and performance difficulties

2. Make sure you have at least 10 MB of free disk space available for a Windows 95 virtual 
memory swapfile to exist. Less than 10 MB of space may cause random crashes.

3. Make sure that you have turned off all other programs on your computer when playing 
the game. To do this, try holding down the Shift key when you are starting Windows 95. 
This will prevent any programs that may be in your Start menu from loading, and should
allow you the memory needed to run A-10 Cuba. 

4. It is recommended that you restart your system after experiencing a crash. This helps to 
ensure that you will not experience any residual effects related to the crash.

5. Some systems employ Advanced Power Management features that shut off the display 
and/or parts of the system when they have been idle for a period of time. These features 
may conflict with the game, and in fact, may cause system crashes. We highly 
recommend that you turn these features off when playing the game.

6. Make sure your hard drive is not compressed.



Game Graphics are Faded or Strange in 
Appearance

1. Make sure your video card is 100% Windows 95-compatible. Using a non-Windows 95-
compatible video card and drivers may result in display problems.

2. Make sure that you have closed all other programs on your computer when playing the 
game.

3. Make sure that your video driver supports 256 Colors in your Color Settings. A-10 Cuba 
for Windows 95 should be played in 256 Colors for optimum performance.

If you purchased your video card before the release of Windows 95, you may obtain 
updated drivers from a variety of places. Most hardware retailers have access to the 
most recent drivers. Additionally, most video card manufacturers maintain a BBS 
containing the latest drivers for free downloading. Drivers are also available on 
CompuServe, America Online, The Microsoft Network and other popular online networks. 
A list of video card manufacturers and their Technical Support and BBS numbers is 
available in this document. Please make every effort to install the latest video drivers 
before calling Activision Customer Support.



Game Updates and/or Patches

(available in English only)

You may check our web page for updates to your game at:

http://www.activision.com

If you are uncertain of a game update and/or patch, please E-mail all questions to our 
internet mailing address at:

support@activision.com



General Troubleshooting for Joysticks and Game 
Pads

1. Make sure your joystick is properly calibrated in Windows 95. To do this, perform the following 
steps:

a. Click on the START button on your taskbar, Select SETTINGS|CONTROL PANELS.
b. Open the Windows 95 CONTROL PANEL folder and double-click the JOYSTICK icon.
c. Select the appropriate settings in the Current Joystick and Joystick Selection drop-down 

menus.
d. Calibrate your controller.

2. Although Windows 95 contains several built-in gamepad and joystick drivers, you may need to 
obtain a Windows 95-compatible driver from the gamepad or joystick manufacturer. 

3. Be sure to connect your input device to the correct joystick port. If you are using a game card to 
run your joystick, be sure to disable the joystick port on your sound card. Please refer to your 
sound card manual for instructions on disabling the joystick port.

4. Make sure your joystick properties are setup for only one joystick.    Please follow the steps 
below:

a. Click on the START button on your taskbar, Select SETTINGS
b. Select CONTROL PANELS.
c. Double-click the JOYSTICK icon.
d. Pull down the menu for CURRENT JOYSTICK and choose JOYSTICK 2.    Make sure 

the Joystick selection down below changes to none.    If it does not say none, select it.
e. Click on the APPLY button.
f. Now, click on the OK button.



How can I improve Performance?

1. Close all other programs while playing. 

2. Set Graphics Acceleration to maximum in your System Control Panel.
a. Go to the Start menu on your taskbar, Select Settings|Control Panels.
b. Double-click on the System icon.
c. Click on the Performance tab.
d. Click on the Graphics button. 
e. In the Graphics box, position the Hardware Acceleration slider to Full.

3. In A-10 Cuba, select the Prefs option, and turn off graphics options under the Graphics tab.



How to Start the Game

How do I start the game? - Basic instructions on how to begin playing the game.



How to Start the Windows 95 Version of the Game

After installing the game, insert the disc into the CD-ROM drive and wait for Windows 95 to display the 
AutoPlay title screen. If this screen does not appear, choose the START button and select PROGRAMS. 
Click on A-10 Cuba and choose A-10 Cuba. Once the title screen appears click the PLAY button to 
launch A-10 Cuba.



I Uninstalled the Game and there is no Option to 
Reinstall it
Unfortunately, the Windows 95 registry thinks the game is installed.    You will want to delete it from the 
registry.    You can do so by following these instructions:

1. Click on the Start button and choose Run. 
2. Type in REGEDIT and then press <Enter>.
3. You should see the regedit screen, double click on HKEY_LOCAL_MACHINE folder. 
4. Now double click on the software folder. 
5. Double click on the Activision folder.
6. Right mouse click on the A-10 Cuba folder.
7. Choose the delete option on the pop up menu.
8. Confirm it by choosing the YES button.
9. Close the regedit application.
10. Put in the A-10 Cuba CD and you should have the option to reinstall now.



I am using large fonts on my system and the 
lettering in the game is messed up, what can I do?

A-10 Cuba was designed to use small fonts.    The only way to get the game to display properly is to 
switch your font size to small fonts. Click here to run the Microsoft Display panel if you wish to make the 
change now.



I have an Advanced Gravis UltraSound ACE and I 
am experiencing severe lock-up problems.

There have been some questions regarding the Gravis UltraSound (GUS) ACE operating in 
Windows 95. Please consult Advanced Gravis regarding updated drivers.



I have only partial or no sound when running the 
game.

1. Make sure your sound card is 16-bit and Windows 95 compatible. Using a non-Windows 
95-compatible sound card and drivers may result in sound problems.

2. Make sure your speakers are plugged in correctly and turned on. Also make sure the 
volume is set at an audible level.

3. Your sound drivers for Windows 95 may require updating. Check the installation and 
setup parameters of your sound card using the Device Manager of Windows 95

If you purchased your sound card before the release of Windows 95, you may obtain 
updated drivers from a variety of places. Most hardware retailers have access to the 
most recent drivers. Additionally, most sound card manufacturers maintain a BBS 
containing the latest drivers for free downloading. Drivers are also available on 
CompuServe, America Online, The Microsoft Network and other popular online services. A
list of sound card manufacturers and their Technical Support and BBS numbers is 
available in this document. Please make every effort to install the latest sound drivers 
before calling Activision Customer Support.



I installed a new video card, and the game doesn't 
look right. What do I do?

If you install a new video card into your system after you have installed A-10 Cuba, you may 
need to uninstall and reinstall    the game in order to get it to properly recognize the new 
hardware. Be sure to uninstall using the uninstaller, because other methods of deleting A-10 
Cuba may erase your saved games. Reinstalling A-10 Cuba will not affect your saved games.
If you choose to reinstall to a new directory, you may have to move your old saved game 
files to the new directory.



I just installed a new sound card. How come I’m not
getting any sound?

Be sure you are using a sound card that is 16 bit and 100% Windows 95-compatible sound 
card. Sometimes Windows 95 fails to recognize your peripheral. If this happens, please 
consult your Windows 95 manual.

Through our testing, we have found that many of the combination sound/modem cards that 
come in many consumer model PC's are not capable of playing back digital audio and 
allowing modem play simultaneously. Please consult the manufacturer of your PC for more 
information.



I've installed the game, set up DirectX, but the 
game screen is blank.

This is a characteristic of having the incorrect video driver loaded. To correct this:

1. Go to the Start menu on your taskbar and select Settings|Control Panels.

2. Double-click on the Display icon, select the Settings tab.

3. Click on the Change Display Type button.

4. From the Change Display Type dialog box, confirm that the adapter type matches the 
card you have installed in your computer. If it is incorrect, click on the Change button.

5. In the Select Device dialog box, choose the correct video adapter. Click OK.

6. In certain cases, you will need to insert your original Windows 95 CD in order to load the 
appropriate driver.

7. After Windows 95 corrects your monitor settings, it will ask you to restart your computer. 
Click Yes and allow the computer to restart.

8. Upon completion of this process, Uninstall A-10 Cuba and then reinstall it.



IBM OS/2 (All Varieties)

Activision Studios does not currently test under or support IBM OS/2.    Please see Supported 
Operating Systems for more information.



ISP: Internet Service Provider



Installing & Uninstalling the Game

Before the installation

Installing   A-10 Cuba   for Windows 95   - This contains install instructions and information 
about this version.

Electronically Registering Your Copy of   A-10 Cuba   (Windows 95)  

Uninstalling the Windows 95 version of the game - Basic instructions on how to 
uninstall the game.



Installing A New Sound Card

If you install a new sound card into your system after you have installed A-10 Cuba, you may
need to uninstall and reinstall the game in order to get it to properly recognize the new 
hardware.



Installing A-10 Cuba for Windows 95

How to Install

1. Before installing, close all other applications. Also make sure Virtual Memory (located in 
your System Control Panel under Performance) is not disabled.

2. Insert A-10 Cuba disc into your CD-ROM drive and wait a few moments until the A-10 
Cuba title screen appears. (If the title screen does not appear, please refer to the 
AutoPlay Troubleshooting section.)

3. Click the Install button to begin the installation process and follow the on-screen 
instructions.

4. After A-10 Cuba installation is complete, your computer will install Microsoft's DirectX 2 
drivers if you do not already have them. After installation of DirectX 2 is complete, you 
will need to restart your computer for the new drivers to take effect. For more 
information on DirectX 2, see the DirectX 2 section of this file.

5. You can now run A-10 Cuba for Windows 95 by choosing Start|Programs|A-10 Cuba|A-
10 Cuba from the Start menu or by clicking Play on the A-10 Cuba title screen.



Introduction to A-10 Cuba

Welcome to A-10 Cuba. We hope you enjoy playing it as much as we have enjoyed creating 
it.

This disc includes a Windows 95 version of the game.

This supplemental documentation is designed as a troubleshooting guide. We will attempt to explain 
in detail the various tips, tricks and troubleshooting techniques we have learned through the
course of our comprehensive testing process.

If you enjoy A-10 Cuba we would appreciate it if you would write to us - or write to your 
favorite games magazine and let them know. We appreciate both positive and constructive 
comments, since they help us learn what you do and don't like!

One point we want to make before we proceed: you should read this Help file to understand 
the features and usage of A-10 Cuba. Many customers can save themselves both time and 
money by reading the information provided for possible solutions. We also recommend that 
users contact us via our online services for support rather than by telephone. Often, a 
solution to your difficulties is already available online which can be accessed and quickly 
downloaded. In addition, we can also provide more comprehensive and detailed assistance 
through our online services.



Joystick Calibration
1. Make sure your joystick is securely plugged into the correct game card. If you have questions on how 

to do this, please see the documentation supplied with your sound and/or game card.

2. Use the Windows 95 joystick calibration program to make sure that your joystick is calibrated 
properly. To do this, go to the Windows 95 Control Panel and click on the Joystick icon. Once you 
have reached the Joystick Control Panel, select the joystick you are using from the menu and select 
Calibrate to set it. Follow the steps and then exit the Control Panel.

3. If you do not see a Joystick icon in the Control Panel, make sure you have a driver installed. To do 
so, go to the Control Panel and select System. Select the Device Manager tab and click on the Plus 
Sign (+) next to Sound, Video and Game Controllers. Your joystick driver should be listed here. Click 
Properties to ensure that there are no conflicts. If you do not have a joystick driver installed, or you 
do not see a Plus Sign (+), follow these steps to install a joystick driver:

a. Go to the Start menu on your taskbar, Select Settings|Control Panels.
b. Double-click on the Add New Hardware icon and then click Next.
c. Select No and press Next.
d. From the list select Sound, Video and Game Controllers and press Next.
e. From Manufacturers select Microsoft, and from Models select Gameport Joystick, then click 

Next.
f. Follow the directions to complete the installation of your joystick driver. 



Minimum System Requirements for Windows 95 
Version of A-10 Cuba

- 100% IBM PC-compatible computer
- Windows 95 operating system
- A 100% Windows 95-compatible computer system (Including 32-bit Windows 95-
compatible drivers for CD-ROM drive, video card, sound and input devices)

- 486DX2/66 MHz processor
- 8 MB RAM
- Single-speed CD-ROM drive (150K/second sustained transfer rate)
- 40 MB of uncompressed hard disk space
- VESA local bus or PCI video with 1 MB RAM
- 256 Color SVGA (640 x 480) video card
- 100% Microsoft-compatible mouse and driver
- 100% Sound Blaster 16 bit compatible sound card
- Dedicated game card is highly recommended for joystick

NOTE: The Windows 95 version uses new Microsoft DirectX 2 technology, and 
requires that your system have the most updated drivers that fully support 
DirectX.

Please Note: In order to play A-10 Cuba for Windows 95 the CD must be in your CD-ROM drive 
at all times.

Click here for information if you have a Nexgen processor and you receive a warning 
message during the install process.



Mouse

Systems with Wraparound Mouse Pointer Features

Some systems may have a mouse driver feature that allows the mouse cursor to "wrap 
around" the screen (e.g., when you move it off the right side of the screen it reappears on 
the left side). This feature may cause problems with the A-10 Cuba interface, and should be 
turned off before playing A-10 Cuba.



My screen saver runs really slow when A-10 Cuba is
running. What can I do about that?

Because A-10 Cuba makes heavy use of the system resources, screen savers may be 
affected in this manner. We highly recommend disabling your screen saver when playing A-
10 Cuba. Click here to open the Windows 95 Help procedure to change your Screen Saver 
settings.



Nexgen

Unfortunately, the Nexgen processor is not recognized as a Pentium processor by Windows 
95. When Windows 95 checks the hardware it detects the processor as a 386. During 
installation the installer checks for verification with Windows 95 that the correct processor 
type is available. Windows 95 reports to the installer that the processor is a 386. There are 
two alternatives that can be used to remedy this problem.    They are as follows:

(The easier solution)
Continue installation, by choosing the NEXT button.    This will not degrade game 
performance.

Or

There is a file that will help the operating system identify the processor correctly. This is 
available from AMD, on their web site. (http://www.amd.com). These files will not improve 
game performance in any way. Before downloading and installing, please make sure you 
choose the correct file for your system.

If you are running a Nexgen processor with a VLB board download UPDTVL30.EXE.    If you 
are running a Nexgen processor with a PCI board download UPDTPI31.EXE. If problems 
persist, contact AMD Technical Support Staff.



Packard Bell with Little or No Sound

If the game has no volume or it is too low you will want to use the mixer utility provided by Packard Bell.     
Please follow the instructions listed below for volume control settings.

1. From MS-DOS Mode or MS-DOS 6.22, type CD\SOUND144\UTILITY and press Enter 
(SOUND144 can be replaced with FORTE16 or SOUND16A depending on the sound card you 
have installed.)

2. Type MIXTSR and press Enter.
3. Hold down the ALT key while you press the / key. This will activate a menu with the following 

options:

TAB Moves your selection choice to the next device to manage.
Right arrow Turns the volumes up.
Left arrow Turns the volumes down.
S Save 
E Exit

Once you are finished choosing your settings in the volume control area follow the next two steps.

1. Start Microsoft Windows 95.
2. Begin game play as you normally would.

If problems persist, contact Packard Bell. 



Power Saver Functions

We have discovered through the course of testing A-10 Cuba that many computers equipped
with a power saver feature in their system CMOS have problems running the game when this
feature is turned on. This feature only activates after the computer is left idle for a certain 
period of time. To solve this problem, you should save your place in the game if you need to 
be away from the computer for a while. Another option is to turn this feature off in your 
system CMOS.



QEMM: Quarterdeck Expanded Memory Manager from Quarterdeck Corp.
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RAM: Random Access Memory



Supported Operating Systems

A-10 supports one operating system at this time; Microsoft Windows 95

The following operating systems are not supported:

MS-DOS 6.22

MS-DOS Mode 7.0

Microsoft Windows NT

IBM OS/2 (All Varieties)



Table of Contents

Please note that this Help File contains information for the complete version of A-10 Cuba. Some 
help items may not apply to this demo, including references to autoplay and the A-10 Cuba CD.

Read me first! 

Game Play - Instructions on how to navigate your plane, along with game tips.

System & setup requirements

Installing & Uninstalling the Game

How to start the Game

Common Troubleshooting Tips - Where to go when you are having problems with the 
game.

Vendor List - A directory of hardware/software companies for compatibility issues.

Activision Customer Support - Information about our support services.

Credits - The folks who helped make this game.

NOTE: For your benefit, we have created a README.TXT file that contains last minute 
information that could not be included in this on-line help file.    If information is not found 
within this on-line help file, please view our README.TXT file.



Taskbar Always on Top

In order to launch A-10 Cuba, the Windows 95 taskbar cannot have the option Always On Top selected.    

For directions on how to turn this option off, please see the Microsoft Help system.    Click Here to display 
the Microsoft Help system subject on Configuring the Taskbar.



The Fonts are too Large and are Extending off the 
Screen

Systems using a font manager, like Adobe Acrobat, installed to Windows 95, may have the 
game fonts appear larger than normal because the font manager will redirect Windows 95 to
use the fonts it supplies. This will cause some text printing across the game window, and the
text sometimes becomes unreadable. The general solution is to disable the font manager 
temporarily.



The volume levels of my music, sounds effects or 
game voices are too low for me to hear. What can I 
do?

Check your speakers to see if the volume can be turned up. This is the easiest solution. However, if this 
does not solve your problem, try adjusting the SoundFx and Music volume sliders in the Options menu of 
the game. Your sound card may have a volume or mixer utility that can raise the volume of your sound 
output. Finally, some sound card models have a volume knob in the back. Consult your sound card 
manual for more information.



To Check Your Display Type Settings

If you are not sure of the type and capabilities of your video card, follow the steps below to 
find out what is currently in your system. Once you know what type of video card is in your 
system, please consult the Vendor List for the company that manufactures it.

1. Place your mouse cursor over an empty area of your desktop and click the right button 
on your mouse. At the bottom of the list that appears, click on Properties, and then 
choose the Settings tab. You can also bring this window up by clicking on the Display 
icon in the Control Panel, and choosing the Settings tab.

2. Click on the Change Display Type button.

3. Under Adapter type in the window that appears, make sure that the adapter type is 
appropriate for your video card.

4. If you are still having problems with your video card at this point, consult the manual for 
your video card or the Vendor List in this document for information on how to contact 
your video card manufacturer.



URL: Uniform Resource Locator. An addressing scheme used to
link resources on the World Wide Web.    Using URLs, a web browser
can point to most resources on the net.



Uninstalling the Windows 95 Version of the Game

How to uninstall A-10 Cuba.

The Uninstall option in A-10 Cuba allows the game to remove itself completely from your 
hard drive. From the Start button go to Programs/A-10 Cuba/A-10 Cuba Uninstall and 
follow the Uninstaller instructions.

NOTE: You should always uninstall the game with the Uninstaller provided.

If you remove the game from your hard drive by dragging your A-10 Cuba folder to the 
Recycle Bin, certain files may be left behind causing problems with a later reinstallation of 
the game. In order to completely remove all A-10 Cuba files from your computer, complete 
the following steps:

1. Make sure you have deleted the entire directory to which you installed A-10 Cuba.

2. Remove A-10 Cuba from the Start menu.

a. Go to the Settings/Taskbar from the Start menu.

b. Select the Start Menu and choose the Programs tab.

c. Click the Remove button.

d. Highlight and then delete the entire A-10 Cuba entry.

3. You must also clean up the Windows 95 Registry, in order to be able to reinstall A-10 
Cuba again.

a. Go to the Start menu on your taskbar, select Run and click.

b. In the Run dialog box, type REGEDIT and click on the OK button.

c. Once REGEDIT is open, double-click the entry called HKEY_LOCAL MACHINE.

d. Double-click on SOFTWARE. If you have any other Activision programs installed, 
open the Activision folder and delete only the A-10 Cuba folder. Otherwise, delete 
the entire item called Activision.



VESA: Video Electronics Standards Association.



VLB: VESA Local Bus. A high-speed bus for graphics cards that provides better video 
performance on high-end machines.



Video Driver Settings

DirectDraw cannot function unless the correct video drivers for your video card are installed.
In certain cases, Windows 95 will function correctly without the correct video drivers 
installed. As a result, it may be difficult for you to diagnose a video driver problem that is 
preventing A-10 Cuba from running. Always check that you have the correct video driver 
installed for your video card.



While I’m playing A-10 Cuba, the image is very 
choppy and slow.

1. Close all other programs while playing.

2. Set your Display to 256 Color in your Windows 95 Control Panel.

3. Set Graphics Acceleration to maximum in your System Control Panel.

a. Go to the Start menu on your taskbar and select Settings|Control Panel.

b. Double-click on the System icon.

c. Click on the Performance tab.

d. Click on the Graphics button.

e. In the Graphics dialog box, position the Hardware Acceleration slider to Full.



Windows NT

The current version of Microsoft Windows NT does not support DirectX, a major component 
of A-10 Cuba; therefore it is not compatible. Please see Supported Operating Systems for 
more information.




